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FormFusion Suite 
Your Intro to any Process…Building a Purchase Order 

 
The following is a brief guide to how the sample purchase order PO_SIMPLE was created.   
We discuss how to: (1) search for keywords, (2) capture a field offset from the search term,  
(3) delete data, (4) print different overlays on different copies, and (5) split the print job 
between different networked printers/bins.    Refer to APPENDIX A for before and after images.   
 
Decisions made by the client: 
 

1. The client did not want the Additional Amount, Discount Amount or Total Taxes fields to 
print.  These fields would always be $0.00.  This is accomplished with the use of offset 
fields in MapForm (as described in more detail below). 

 
2. The client also decided that there was a need for 3 printed copies – the first copy was for 

the vendor and would be printed on special blue paper.  The other 2 copies were for 
internal departments (Receiving and Accounts Payable) and could be printed on standard 
paper.   This is done by setting the properties of the Special Print Parameter and by setting 
the print option on the pcl form itself. 

 
Getting Started: 
 
Beginning the design process, it is helpful to import a template that closely matches what you are 
working towards.  By simply importing/opening your sample template (in this case the po_simple.ffe) 
you will be able to see what we did to meet the clients needs and be able to make your own 
modifications.  Please refer to APPENDIX B to see the details on how we got to this point. 

 
1.  Using Offset fields in Mapform   
 
The first step in creating any template typically is to create the MapForm.  The use of MapForm is 
straightforward. First, you need to add a MapForm node beneath a Special Print Parameter. Once 
you have added the node, you can open it and import a "sample print file" from the process you are 
enhancing. This sample print file should be in the format that the process would normally produce. 
Once imported, each page will be shown one page at a time. You are free to navigate through the 
pages as necessary. Use your mouse and draw areas (called "floating fields") on the normal printed 
page. Name each field appropriately to denote what information will normally appear at that location.     
(See Help: Working with MapForm for additional help) 
 
For this sample, we pulled in a listing from the FPAPORD process.   When pulling in a list file, you will 
be prompted for some default settings (Number of rows, columns and if a ^L will be used for a page 
break or not.  FormFusion helps you make these decisions by calculating values on what it finds on 
the first page.  You may always change these defaults at a later date,  (see HELP: Special Print 
Parameter: Input file settings for more information). 
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By using MapForm the fields were marked and identified with appropriate names.  We will discuss 
how the Offset feature was used to handle the special fields Additional Amount, Total Taxes and 
Discount Amount.   
 

 This is the Draw Offset Field tool button. Click this tool 
button to create an offset field on the form. You will first be 
prompted to enter a variable name.   Enter the name you want 
to associate with this field and click “OK.”       
 
 
 
 
 
The Offset field properties form will then be displayed.   On this form you will enter the word or set of 
characters you are searching for and where on the page this string could be found.  Finally, if found, 

where is the data that you want to map.    For the 
Additional amount field, we will search for the 
characters “ADDL” between columns 76 and 79 
and rows 1 to 44.  If the search text is found, the 
data we are interested in is 15 columns to the left 
of the first character of the string being searched 
for (i.e. starting in column 90) and is 15 characters 
long.   The next decision is what to do with the text 
if found.  Again, in this example, we do not want to 
print the words “Additional Amount” so we will 
remove the entire line from the report.   
 
Note that although the entire line is going to be 
removed from the report, the data that has been 
mapped is still available to be placed on the form if 
desired.  
 
For more information on using the Offset field, 
please refer to the Help: Offset Field Properties 
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2.  Copies 
 
The designing of the template named PO was pretty straightforward.  FormFusion PCL Form is 
basically a "digital template" which you can overlay onto any output stream from a process run on 
your Banner system. The PO template or form contains all the design elements that will be printed on 
all copies of the purchase order.   

Every form also has what we refer to as 
Form Properties.  To edit the form 
properties, open the form you wish to edit. 
On the "Tools" menu, click "PCL Form 
Options".  On the PCL Form tab in the "Form 
Properties" Dialog you can edit the form 
name, author name, manager name, 
company name and any comments about the 
form. These fields are for internal 
management and are not used by 
FormFusion in any way.   On the Form 
Layout tab you can set such things as the 
paper size and the resolution to print the 
document.  See HELP: Form Properties for 
more information on these tabs. 

The Overlay Tab is where you indicate on 
what copy to print a particular form and if it 
should print on the front or back or both 
sides.   In the Print on Copies field you can 
enter the copy (or copies) the form will be 
printed on. For example, if you want a form 

to print on copies 1 and 3, enter "1, 3" (no quotes). To print on copies 2, 3 and 4, enter "2-4". When a 
copy number is not specified, the form will print on all copies. If a form is being modified or is not 
currently needed and should not be printed on any form, you can specify copy 0. This will cause it to 
never print.  For the PCL form named PO, this value was left blank.  For the PCL Form named 
VENDOR, the value of 1 was entered.  A value of 2 was used for the Receiving copy and a value of 3 
for the AP copy.  For all, the Front radio button was clicked.  Note if we wanted to print something on 
the back of copy 1 (such as Terms) we would place a 1 on the Print On Copies and check the Back 
radio button. 

Although PO_SIMPLE does not have watermarks, many clients will create an overlay in a large 
shaded font saying “Vendor,” “File,” “Department,” etc.  They will then specify over which page this 
text is supposed to print.  This is a very simple way to clearly distinguish which copy is which, when 
it’s all printed on inexpensive blank paper. 
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The next step to set up the printing of 
three copies is to set the “properties” of 
the Special Print Parameter itself.  To 
alter the properties, highlight the Special 
Print Parameter (PO_Simple in this 
example) and right click.  Select 
“Properties” from the displayed menu.   
We are interested in the Copies tab.  
You can find information on the other 
tabs by looking in the Help: Special 
Print Parameter Properties.   The 
Copies controls the number of copies 
and the rendering of each copy on the 
printed page. The copies to process are 
listed in the large list in the center of the 
dialog. The first copy to process is listed 
at the top and the last copy to process is 
listed at the bottom. To add a new copy 
to the list, click the "Add Copy" button. 
This will add a copy with the default 
properties at the bottom of the list. To remove a copy, click the "Remove Copy" button. This will 
remove the bottom copy.   Because we wanted to print the first copy (the copy going to the vendor) 
on special paper, we indicate the paper tray where the paper will be pulled from.  This value differs 
from printer to printer and may not correspond to the physical paper tray number stamped on the 
printer itself.  For more information on determining what value should be entered here, please refer to 
the HELP: Special Print Parameter Copies.  Note that all other copies will be pulled from the default 
tray. 
 
Please consult with your technical contact, if you would like further details on any part of this 
document.   
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FormFusion Suite 
Your Intro to any Process…Building a Purchase Order  
 
Appendix A: Before and After 

 
 
 

 
Figure 1 Before - Baseline Banner Output 
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Figure 2 After FormFusion 
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FormFusion Suite 
 
Appendix B:  Getting Started  
Before you delve into the advanced concepts found elsewhere, you may like to review just how 
simple it is to begin.  You can literally take one of our pre-designed Banner process templates, import 
it, add your logo and details, and go into production in minutes.  How long further customizations take 
is entirely up to you.   

Select a Database  

Log in to a database session.  On the left-hand side of the application window you will 
find a panel with three buttons and a drop-down combo box.  First you need to select 

the Oracle SQL*Net session you would like to 
connect to. The sessions in the drop-down list are 
read from the "tnsnames.ora" file. If the session is not 
in the drop-down list, you may type it into the edit 

box. Select a session from the drop_down box    Every time you exit FormFusion the 
last session used is saved to the Windows(tm) Registry. The next time you return to 
FormFusion, the session will be displayed in the box automatically.  

Log in    

After the session has been chosen, click on the Login icon.     Alternatively, you 
can type the shortcut keys <CTRL> and L. At this point, you will be prompted for a 
Username and Password. The session drop-down list will become disabled disallowing 
the option to change the Oracle session.  

After the session is logged in, assuming there were no warning messages, you should 
see a view of the FormFusion table structure. The tree view may or may not contain 
groups and processes at this point. This will depend on whether your DBA installed the 
Evisions Sample Forms or have created forms for your organization's use.  

Process Tree   

This section will discuss the layout and organization of the "Process Tree View." This can also 
be thought of as the view into FormFusion tables residing in the Oracle session. Each entry in 
the tree view is called a "tree node" (or "node" for short). Each node represents an entry in one 
or more of the FormFusion tables.  
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"Process Group Nodes" are containers for other group nodes or process nodes. "Process 
Nodes" are containers for special print parameter nodes. "Special Print Parameter Nodes" are 
containers for the process modifier nodes. "Process Modifier Nodes" are all nodes that add a 
new feature to a special print parameter. Each plug-in provides a different process modifier 
node type.  

A Closer Look  

Node type Description 

 Process 
Group 

Each group node is pulled from the EVIPGRP table. A group can contain other groups or processes. A group can 
contain nothing else and has no configurable properties of its own. When you choose a group node in the tree 
view, additional options become available in the "Edit" and "Tools" menus. A group can be added to the root level 
(no parent node). 

 Process 
Each process node is pulled from the EVISCTP table. A process can only contain a special print parameter. There 
are no configurable properties to a process. When you choose a group node in the tree view, additional options 
become available in the "Edit" menu. A process can be added to the root level (no parent node). 

 Special Print 
Parameter (SPP) 

Each SPP is pulled from the EVISPP table. An SPP can only contain process modifier nodes. By selecting the 
node in the tree view, additional options become available in the "Edit" menu. The "properties" of the special print 
parameter can be modified by either choosing the "Edit | Properties" menu option or right-clicking and selecting 
"Properties" from the popup menu. Also, each type of available process modifier can be selected from the "Edit | 
New" menu or popup menu. For more information on changing properties and adding process modifiers see 
Working with Special Print Parameters 

Process Modifier There are multiple process modifier types. Each will be described in detail below. In general, each process modifier 
is pulled from the EVIPMOD table. Each process modifier is a configurable node and may or may not house any 
child nodes. 

CaptureForm Plug-In 

 CaptureForm The CaptureForm node is linked to EVIPMOD using the EVICFORM table. Choosing "properties" for a 
CaptureForm node will bring up the CaptureForm properties dialog box. There, you can add any custom SQL 
queries that should execute for the process and special print parameter when executed on the server. For more 
information on changing properties and creating the queries, see Using CaptureForm-SQL 

FormDirector Plug-In 

 FormDirector The FormDirector node is linked to EVIPMOD using the EVIFDDIR table. Choosing "properties" for a FormDirector 
node will bring up the FormDirector properties dialog box. There, you can specify which directors should be used 
for the process and special print parameter when executed on the server. Each director uses a different table to 
store its information: EVIFDARC, EVIFDEML, EVIFDFAX, EVIFDPRT, and EVIFDWEB. For more information on 
changing properties and redirecting output, see Using FormDirector 

FormStamp Plug-In 

FormStamp provides for two process modifier nodes. Each FormStamp node is linked to EVIPMOD using the EVIFSTMP table. For 
more information on these two types of nodes and configuring FormStamp see Using FormStamp. 

 PCLForm 
The first node type is PCLForm which is a graphical designing tool allowing for the drawing of graphics, shapes, 
text, and data fields. The node is linked to EVIFSTMP using the EVIPCLF table. Some properties are available to 
edit when the PCLForm is closed but most properties are only editable when the node is opened. Open by either 
double-clicking the node or choosing "Open" from the "Edit" or popup menus.  

 MACFile 
The second node type is MACFile. This node type is rarely used and is merely a non-editable PCL file. Properties 
are the same for the MACFile as they are for the PCLForm when the nodes are closed. The MACFile cannot be 
opened. 

MapForm Plug-In 

 MapForm 
The MapForm node is linked to EVIPMOD using the EVIMAPF table. Properties for a MapForm are only available 
when the MapForm is opened. To open a MapForm node either double-click the node or choose "Open" from the 
Edit or popup menus. The properties of a MapForm node can also be found in the special print parameter node. 
See Using MapForm for details on configuring and using this plugin. 
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 Importing a sample Group File 
    

Select the process group to import the file beneath.  If you would like to import the file to the root level 
then select the empty area of the process tree view (no node selected).  

 In the "Tools" menu, click "Import from File".  If you want to import a file 
that was saved in a different folder, locate and open the folder that 
contains the list of available import group files. 

 

 

Double-click the file you want to open 
(Note: the filename will have a .ffe 
extension). The imported file will be 
placed beneath the currently selected 
group and the tree structure within that 
file will be created.  

 

 
 
 
 
 
 

 
A  status screen indicating what is being imported will be displayed.  Upon completion, this screen will 
be closed and the process node will have been imported.  In this sample, the process node is named 
Billing_Invoice. 
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